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1 Installation

It's recommended to uninstall previous KNX Eno Tool versions before installing the new one. Run the
setup installer Setup_ KNXEnoTool.exe and follow all the instructions in the appearing dialog boxes.

2 Requirement

The KNX Eno Tool can be installed on Windows 7, Windows 8, Windows 8.1 and Windows 10.

3 General

The KNX ENO Tool is a KNX EnOcean link configuration and bus monitor tool for the Weinzierl

KNX ENO 626, 63x product line. It can be used to configure links between different EnOcean devices
and the EnOcean Gateway.

The teach-in process of sensors and actuators can be completely remote-controlled via the software.
The existing configuration of a Gateway can be read out, changed on the PC, archived and transferred
back to the same or another gateway.

In addition, a bus monitor is included to display EnOcean telegrams via the KNX bus.

o

I_f! E knx.usb USB1({TP) 15.15.53 g". :/‘.;

KnxEno_15-15-60* [E]

Device Address Remote Device Session Device Name Toggle Bus Monitor View
15.15.60 Read Learn | (oo == i KNX ENO 636 Bus Monitor View

Channel number  Secure Function Device EEP Title D1 D2 D3 o4 & |

1 Sensor F6-02-01 Switch Unsecure 002549 1F FF FF FFFF FF FF FF FF FF FFFFFF

H B

2 = Sensor D2-03-00  Switch Secure FF FF FFFF FF FFFFFF FF FF FF FF FF FF FF FF

3 [ Actuator (bi) D2-01-03 VLD Aktor FF FFFFFF

[

Sensor D2-06-01 Trgriff Kiche FFFFFFFF

= g

Unused

Unused

Unused

Unused

Unused

Sensor D203-00  Switch FF FF FF FF FF FF FFFF FF FF FFFF FF FF FF FF

Unused

Unused

Unused

Unused

Unused

Unused
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KNX Eno Tool: Main Window
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Note: The basic configuration of a device has to be done in the ETS. There you can configure the
general settings, like the device name or add and configure the channels. The KNX Eno Tool
reads this configuration and allows the user to use different helpful functionalities, like adding or
removing links.

The following devices are supported:

KNX ENO 630

KNX ENO 632

KNX ENO 634

KNX ENO 626 secure

KNX ENO 636 secure

Note: There is a separate tool for the KNX ENO 620 and KNX ENO 622 devices, which can be
downloaded from our website.

4 The Main Menu

The main menu provides all important functions of the KNX Eno Tool. In addition to basic features like
creating a new configuration or opening an existing configuration, here are also the elements for
searching and opening a KNX interface.
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File Settings Window 7
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kroc.usb + 1USB1(TP) 15.15.53 - | @

KNX Eno Tool: Main Menu

4.1 File
It is possible to open a new, empty configuration via "New" (Ctrl+N). This will be opened in the
configuration window, in a new tab.

Using the menu item "Open" (Ctrl+0O), already created and saved configurations can be opened in order
to subsequently change them again or to load them into another device.

When selecting the menu item "Save" (Ctrl+S), the currently selected configuration can be saved. If this
is the first save operation for this configuration file, a new window opens in which the storage location
and a file name must be specified. At each subsequent process, the save is made directly.

With "Save as" (Ctrl+Alt+S) an already saved configuration can be saved under a new name. This is
useful, for example, for changes where the initial configuration should not be lost.

Note: The mentioned functions can also be selected via the quick selection icons directly under the
menu item "File".

There is also the possibility to open "Recent files" and "Exit" (Alt+F4) the application.

Mew Ctrl+M
Open... Ctrl+0

1 Save Ctrl+5

'g l  SaveAs... Ctrl+Alt+5
Recent files r
Exit Alt+F4

KNX Eno Tool: File Menu

4.2 Settings

In the Settings menu, the language of the KNX Eno Tool can be selected via "Language". Available
languages are currently German and English.

4.3 Window

The "Window" menu contains all functions concerning the configuration window. Selecting "Close" will
close the currently selected configuration. When selecting "Close All"* all open configurations will be
closed.

Note: If an attempt is made to close a configuration in which there are still unsaved changes, a
warning window is displayed. It is possible to save or discard the changes.
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The functions "Cascade", "Tile Automatically”, "Tile Horizontally" and "Tile Vertically" allow arranging the
opened configurations differently. When selecting one of these functions the configuration windows are
released and can be manually arranged within the configuration window.

With "Next" and "Previous" you can jump between the individual configuration windows - either to the
next one - or to the previous one. The order is determined by the order opened in the KNX Eno Tool,
with the starting point being the currently active window.

Close Ctrl+F4
Close 4ll

Cascade

Tile Automatically
Tile Horizontally

| Tile Vertically
1
et Ctrl+Tab
Previous Ctrl+5hift+Backtahb

1 KnxEno_15-15-60[]
2 KnxEno_15-15-255[*]
3 KnxEno_15-15-255[*]

v 4KnxEno_15-15-255[*]

KNX Eno Tool: Window Menu

Note: At the bottom of the "Window" menu, all currently open configuration files are displayed in order
and the active window is marked with a check mark.

4.4 ?-Help

In the Help menu, the user manual can be opened via "Help".
"Info" opens a small information window that contains a short description of the KNX ENO Tool as well
as the version designation.

5 Searching and Opening KNX Interfaces

In order to read and write configurations, a connection to the KNX bus via a KNX interface is required.
To find available KNX interfaces, a search process is already carried out at the start of the KNX Eno
Tool.

However, KNX interfaces added later can be found at any time with a manually started search process,
by just clicking on the "Search" button.

To open a KNX Interface, the connection type has to be selected first. If KNX IP Routing should be used
you have to select "knx.ip.routing", for KNX IP Tunneling, choose "knx.ip.tunneling”. KNX USB
interfaces can be found under "knx.usb". The found interfaces are displayed in the adjacent DropDown
Box with corresponding information, such as IP address or individual address (depending on selection
and configuration).
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For KNX IP Tunneling Interfaces, there is an additional "Custom tunneling port”. With this a KNX IP
Interface can be selected with its IP address and port (default KNX Port is 3671). This port always uses
the NAT mode, to be able to use interfaces over the internet.

—

=

r

knc.ip.tunneling = | Custom bunneling port * P [192.168.1.16 | Part |3e71 |3

KNX Eno Tool: ToolBar Custom tunneling port

Once an interface has been selected, a connection can be established, by clicking on the "Connect"
button. To close a connection to an interface, just click on the "Disconnect" button.
5.1 Change Interface Settings

Selecting "Configuration" opens a window with the interface settings. In this window the settings of the
current interface can be read and the Individual Address of the interface can be edited.

f]." Interface Settings

Property Mame Walue
‘Media Types TP
Protocol cEMI
Individual Address 15.15.250 = OuFFFRA
Serial Nurmber 00C501 FFACES
Manufacturer (wC5

Carcel

KNX Eno Tool: Interface Settings

Note: The new Individual Address has to be selected according to the topology of the KNX
Installation.

6 The Configuration Window

The configuration window is the main window of the KNX Eno Tool. Here, the configurations of Eno
devices can be read out, changed or transferred to a new device.

It is divided into two areas. On the one hand the menu area in which a Eno device can be connected,
additional options are provided and the bus monitor can be opened. On the other hand the configuration
table which displays the read configuration data.
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Device Address Remote Device Session Device Mame Toggle Bus Monitor View
15.15.80 Read Learn & T =R Bus Monitor View

Channelnumber Secure Function Device EEP Title D1 D2 D3 D4
‘I Sensor F6-02-01 Switch Unsecure 00 25 49 1F FF FF FF FF FF FF FF FF FF FF FF FF
2 .................................. “|'I Sensor D2-03-00  Switch Secure FF FFFF FF FF FF FF FF FF FF FF FF FF FFFF FF
3 ':’:’ Actuator (bi) D2-01-03 VLD Aktor FF FFFF FF
4 Sensor D2-06-01  Targriff Kiche FF FFFFFF
5 Unused
6 Unused
7 Unused
8 Unused
9 Unused
10 El Sensor D2-03-00  Switch FF FFFF FF FF FF FF FF FF FF FF FF FF FFFF FF
n Unused
12 Unused
13 Unused
14 Unused
15 Unused
16 Unused

KNX Eno Tool: Configuration Window

6.1 The Menu Area

In the menu area it is possible to enter the individual address of the Eno Gateway. Alternatively, a Eno
Gateway can also be recognized in programming mode with the "Read address" button and its address
can be entered automatically. Please note that only one Eno Gateway is in programming mode.

Device Address

15.15.60 Read Learn

KNX Eno Tool: Device Address in the Configuration Window

The "Device Name" area displays the device name entered in the ETS configuration
(KNX Eno 626 + 636) or the device type (KNX Eno 630 + 632 + 634).

To open a bus monitor in which all transmitted Eno telegrams are displayed, click on the button "Bus
Monitor View".

In the menu area "Remote Device Session" you can manage the device. Via the Connect button a
connection to the device can be established. With the Close button it can be closed again.

Using the "Write" button, link ID's that have been changed in the configuration table can be written
directly into the device.

Note: When executing the link write process, the device is restarted!
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6.1.1 The Link Configuration Window

Behind the "Interactive Remote Control Session" button hides the link configuration window. Here, new
links can be added or removed. To add a new link, just click on the “Add Link” button to activate the
“Learn mode”. The ID of the next device which sends a Teach-In telegram is added to the links. You can
also delete all links.

With the arrow buttons or the drop-down menu you can switch between the configured channels.
I KNX Eno Tool ? X

Page |Channel 1 Sensor [Switch Unsecure] [Fe-02-01] -

1 Switch Unsecure peEE
Free
Sensor [Fa-02-01] Free
Free

0o EE b =]

KNX Eno Tool: Link Configuration Window

6.1.2 Manage the Base ID
With a click on the button "Manage Base ID" an administration window opens in which the Eno Base ID
of the connected Eno device can be changed.

The new Base Id can easily be entered into the appropriate fields and then written into the device by
clicking on the "Set ID" button.

ﬁ;. Erm Tam
Base ID

FF a4 EI AD SetID

Remaining Cycles 7

Identifies the number of times the EnQcean Base ID can be written.
If the value is 0 the ID can no longer be written.

The ID base is used for sending Enocean telegrams where the send
ID is the base ID + the channel number - 1.
It's useful to change ID if you have two devices with the same ID,

Close

KNX Eno Tool: Base ID Window

Note: The number of remaining cycles indicates how often the Eno Base Id can still be written. If the
value is 0, the ID cannot be changed anymore.
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6.2 The Configuration Table

The configuration table shows the read configuration of the connected Eno device. Information of the
particular channel is displayed, sorted by channel number.

Channel number Secure Functiocn Device EEP Title 01
1 Sensor F&-02-01 Switch Unsecure 0025491F
2 E| Sensor D2-03-00  Switch Secure FF EF FF FF
3 'f;' Actuator (bi) D2-01-03 YLD Aktor FF FF FF FF
4 Sensor D2-06-01  Targriff Kiche FF FF FF FF

KNX Eno Tool: Configuration Table in the Configuration Window

The Configuration Table contains following Information:

Label Description
Channel number Number of the Channel
Secure Channels marked with a lock have been configured as secured in the ETS
Function The device connected to the channel is displayed visually
Device Description of the device (sensor or actuator)
EEP EnOcean Equipment Profile of the device connected to the channel
Title The channel designation text configured in the ETS
D The device ID's connected to this channel

Note: The ID's can be edited directly with a double click in the respective cell. After changing an ID, it
is displayed in red to signalize a change. The "Write" button from the menu area can be used to

transfer the changes to the device.

7 The BusMonitor

The BusMonitor displays information of sent and received telegrams. It can be opened via the
"BusMonitor View" button in the menu area of the configuration window. The telegrams are numbered
with time specification and displayed in tabular form.

In addition to the sending direction (sending or receiving), there is also displayed the type of the
telegram (Eno data, KNX, Eno Teach-In, Eno Teach-In(secure)).

In addition, the data (in the case of Eno data or KNX telegrams), the ID of the transmitter, as well as the
EEP/RORG information and the connection quality (RSSI), are shown.

For later analysis of communication traffic, the BusMonitor list can also be saved using "Save" or "Save

as...".
If the content of the BusMonitor list is no longer necessary, it can be removed using the "Delete" button.

Afterwards the BusMonitor is completely empty again.

n
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[ 4
Commands
: Clear @ Save as... !.—‘ Save
Num  Timestamp 1 Type Data D EEP/ROI RSSI ~
0026  2019-02-26 08:20:21 135 1 Enc Teach-In 00 25 49 1F [ ||
aoz27 201%-02-26 08:20:21 167 1 Enc Data Q0 00 00 00 00 25 43 1F Fe-—. 1l
0028  2019-02-26 08:20:21 167 1 Enc Teach-In 00 25 49 1F [ ||
0029 2019-02-26 08:20:24 &83 1 Enoc Data 30 00 00 00 00 25 49 1F Fé-———_ ..l
0030  2019-02-26 08:20:24 792 1 Enc Teach-In 00 25 49 1F . ||
0031 2019-02-26 08:20:24 839 _L ENX 01 00 00 00 GO nr: 1
0032 2019-02-26 08:20:25 058 _t Enc Data 00 00 00 00 00 25 49 1F Fé---_ ..l
0033 2019-02-26 08:20:25 074 1 Eno Teach-In 00 25 48 1F s ||
0034 2019-02-26 028:20:2¢ 248 1 Eno Data 30 00 00 00 00 25 4% 1F Fe-—- 1l
0035 2019-02-26 08:20:26 402 1 Eno Teach-In 00 25 48 1F s | |
0038 201%-02-26 08:20:2¢ 413 L m 01 00 00 00 GO nr: 1
0037 2019-02-26 08:20:268 480 1 Enc Data 96 00 00 0% 01 25 1E DA 0
0033 201%-02-26 08:20:26 589 1 Enc Data Q0 00 00 00 00 25 4% 1F - .||
0039 2019-02-26 08:20:26 683 1 Eno Teach-In 00 25 49 1F -l v
KNX Eno Tool: BusMonitor
Note: When analyzing the connection quality (RSSI), make sure that it is at least 2 otherwise the
transmission is unreliable. There might be a loss of data due to other, changing, external
influences.
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